Journal of Visualized Experiments

Implantation of combined telemetric ECG- and blood pressure transmitters to
determine spontaneous baroreflex sensitivity in conscious mice

Article Type:
Manuscript Number:

Full Title:

Corresponding Author:

Corresponding Author's Institution:
Corresponding Author E-Mail:
Order of Authors:

Additional Information:

Question

Please specify the section of the
submitted manuscript.

Please indicate whether this article will be
Standard Access or Open Access.

Please indicate the city, state/province,
and country where this article will be
filmed. Please do not use abbreviations.

Please confirm that you have read and
agree to the terms and conditions of the
author license agreement that applies
below:

Please provide any comments to the
journal here.

--Manuscript Draft--

Invited Methods Collection - JoVE Produced Video
JoVE62101R1

Implantation of combined telemetric ECG- and blood pressure transmitters to
determine spontaneous baroreflex sensitivity in conscious mice

Stefanie Fenske, Dr.
Ludwig-Maximilians-Universitat Munchen
Munich, Bavaria GERMANY

Ludwig-Maximilians-Universitat Munchen
stefanie.fenske@cup.uni-muenchen.de
René D. Rétzer

Verena F. Brox

Konstantin Hennis

Stefan B. Thalhammer

Martin Biel

Christian Wahl-Schott

Stefanie Fenske, Dr.

Response

Medicine

Open Access (US$4,200)

Munich, Bavaria, Germany

| agree to the Author License Agreement

Powered by Editorial Manager® and ProduXion Manager® from Aries Systems Corporation


https://www.jove.com/files/Author_License_Agreement.pdf

Manuscript Click here to access/download;Manuscript;62101_R1_RE.docx 2

1  TITLE:
2  Implantation of Combined Telemetric ECG- and Blood Pressure Transmitters to Determine
3 Spontaneous Baroreflex Sensitivity in Conscious Mice
4
5  AUTHORS AND AFFILIATIONS:
6 René D. Roetzerl, Verena F. Brox!, Konstantin Hennis?, Stefan B. Thalhammer?!, Martin Biel?,
7  Christian Wahl-Schott?*, Stefanie Fenskel3"
8
9 ICenter for Integrated Protein Science (CIPS-M) and Center for Drug Research, Department of
10  Pharmacy, Ludwig-Maximilians-Universitat Miinchen, 81377 Munich, Germany
11 2Hannover Medical School, Institute for Neurophysiology, 30625 Hannover, Germany
12 3German Center for Cardiovascular Research (DZHK), Partner Site Munich Heart Alliance, 80802
13 Munich, Germany
14
15  *Corresponding authors
16  Christian Wahl-Schott (Wahl-Schott.Christian@mh-hannover.de)
17  Stefanie Fenske (Stefanie.Fenske@cup.uni-muenchen.de)
18
19  Email Addresses of Co-Authors:
20  René D. Roetzer (Rene.Roetzer@cup.uni-muenchen.de)
21  VerenaF. Brox (Verena.Brox@cup.uni-muenchen.de)
22 Konstantin Hennis (Konstantin.Hennis@cup.uni-muenchen.de)
23 Stefan B. Thalhammer (Stefan.Thalhammer@-cup.uni-muenchen.de)
24  Martin Biel (Martin.Biel@cup.uni-muenchen.de)
25  Christian Wahl-Schott (Wahl-Schott.Christian@mh-hannover.de)
26  Stefanie Fenske (Stefanie.Fenske@cup.uni-muenchen.de)
27
28 KEYWORDS:
29  baroreceptor sensitivity, baroreflex, telemetry, arterial blood pressure, electrocardiogram
30 ECG, sinoatrial node function, autonomic nervous system, diagnostic marker, cardiovascular
31 disease, mouse model
32
33  SUMMARY:
34  The baroreflex is a heart-rate regulation mechanism by the autonomic nervous system in
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40 ABSTRACT:
41  Blood pressure (BP) and heart rate (HR) are both controlled by the autonomic nervous system
42  (ANS) and are closely intertwined due to reflex mechanisms. The baroreflex is a key homeostatic
43  mechanism to counteract acute, short-term changes in arterial BP and to maintain BP in a
44  relatively narrow physiological range. BP is sensed by baroreceptors located in the aortic arch
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and carotid sinus. When BP changes, signals are transmitted to the central nervous system and
are then communicated to the parasympathetic and sympathetic branches of the autonomic
nervous system to adjust HR. A rise in BP causes a reflex decrease in HR, a drop in BP causes a
reflex increase in HR.

Baroreflex sensitivity (BRS) is the quantitative relationship between changes in arterial BP and
corresponding changes in HR. Cardiovascular diseases are often associated with impaired
baroreflex function. In various studies reduced BRS has been reported in e.g., heart failure,
myocardial infarction, or coronary artery disease.

Determination of BRS requires information from both BP and HR, which can be recorded
simultaneously using telemetric devices. The surgical procedure is described beginning with the
insertion of the pressure sensor into the left carotid artery and positioning of its tip in the aortic
arch to monitor arterial pressure followed by the subcutaneous placement of the transmitter and
ECG electrodes. We also describe postoperative intensive care and analgesic management. After
a two-week period of post-surgery recovery long-term ECG and BP recordings are performed in
conscious and unrestrained mice. Finally, we include examples of high-quality recordings and the
analysis of spontaneous baroreceptor sensitivity using the sequence method.

INTRODUCTION:

The arterial baroreceptor reflex is the major feedback control system in humans which provides
a short-term - and possibly also longer term? - control of arterial blood pressure (ABP). This
reflex buffers perturbations in BP that occur in response to physiological or environmental
triggers. It provides prompt reflex changes in heart rate, stroke volume, and total peripheral
arterial resistance. The reflex originates in sensory nerve endings in the aortic arch and carotid
sinuses. These nerve terminals make up the arterial baroreceptors. The somata of nerve
terminals in the aortic arch are located in the nodose ganglion while those of nerve terminals in
the carotid sinus are located in the petrosal ganglion. The reflex is triggered by an increase in
blood pressure, which stretches and activates the baroreceptor nerve terminals (Figure 1A).
Activation results in action potential volleys which are transmitted centrally via the afferent aortic
depressor and carotid sinus nerves to cardiovascular brain stem nuclei such as the nucleus tractus
solitarii and the dorsal nucleus of the vagal nerve. Changes in afferent nerve activity in turn
modulate the autonomic efferent activity. Increased activity of baroreceptor nerves decreases
sympathetic and increases parasympathetic nerve activity. Thus, the consequences of activation
of baroreceptors are a reduction in heart rate, cardiac output, and vascular resistance which
together counteract and buffer the increase in blood pressure3. By contrast, decreased activity
of baroreceptor nerves increases sympathetic and decreases parasympathetic nerve activity,
which increases heart rate, cardiac output, and vascular resistance and thus counteract the
decrease in blood pressure.

Numerous studies in humans and animals have demonstrated that the baroreceptor reflex can
be adjusted under physiological conditions such as exercise?®, sleep®, heat stress®, or pregnancy’.
Additionally, there are evidence that the baroreflex is chronically impaired in cardiovascular
diseases, such as hypertension, heart failure, myocardial infarction, and stroke. In fact, baroreflex
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dysfunction is also utilized as a prognostic marker in several cardiovascular diseases®1°.
Furthermore, dysfunction of the baroreflex is also present in disorders of the ANS. Given the
importance of the baroreceptor reflex for health and disease states, in vivo estimation of this
reflex is an important component of autonomic and cardiovascular research with certain serious
clinical implications.

Genetic mouse lines are essential tools in cardiovascular research. In vivo studies of such mouse
lines provide valuable insights into cardiovascular physiology and pathophysiology and in many
cases serve as preclinical model systems for cardiovascular diseases. Here we provide a protocol
for telemetric in vivo ECG and BP recording in conscious, unrestrained, freely moving mice and
describe how baroreflex sensitivity can be determined from these recordings using the sequence
method (Figure 1B). The applied method is called the sequence method, because the beat-to-
beat series of systolic BP (SBP) and RR intervals are screened for short sequences of three or
more beats during spontaneous increase or decrease in SBP with reflex adaption of the HR. This
method is the gold-standard for baroreflex sensitivity determination since only spontaneous
reflex mechanisms are investigated. The technique is superior to older techniques that involved
invasive procedures such as injection of vasoactive drugs to induce BP changes.

[Place Figure 1 here]
PROTOCOL:

Perform all animal studies in compliance with local institutional guidelines and national laws on
animal experimentation. For this experiment, the studies were approved by the Regierung von
Oberbayern and were in accordance with German laws on animal experimentation. C57BL/6)
mouse strain is used in this report. The animals of the sick sinus syndrome mouse model
(Hcn4tm3(Y527FR669E,T670A)BIEN) 11 (isp|qying increased BRS sensitivity were maintained on a mixed
C57BL/6N and 129/SvJ background.

1. Equipment setup

1.1. Remove telemetric transmitters from their sterile package and shorten the ECG leads of
a transmitter to the length appropriate for the size of the mouse. For a 12-week-old male black
six mouse (C57BL/6J), weighing ~30 g, shorten the positive lead (red) to a length of ~45 mm and
the negative lead (colorless) to a length of ~40 mm using scissors.

NOTE: These values are given as orientation and must be adapted as necessary (Figure 2).

1.2. Remove approximately 6 mm of the ECG lead’s silicone tubing using a scalpel to expose
the wire. Cover the tips of the wire with excessive tubing leaving a ~2 mm portion of ECG wire
uncovered to record electrical signals. Secure the silicone tubing with non-absorbable 5-0 silk

suture material (Figure 2A).

1.3.  Write down the transmitter serial number into the operation protocol (Supplemental
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File 1).
1.4. Hydrate the transmitter in warm, sterile 0.9 % NaCl solution.
1.5.  Weigh the mouse and record its weight.

1.6.  Autoclave all surgical instruments prior to the surgery. Sterilize them during surgery and
between operating different animals by dry heat using a hot glass bead sterilizer.

NOTE: Surgical instruments must cool down to room temperature before use to prevent skin
burns.

1.7.  Disinfect the work bench to assure aseptic conditions.

2. Surgical implantation of telemetric transmitters for combined ECG and blood pressure
measurements

2.1. Dissection of the left common carotid artery.

2.1.1. Anesthetize a mouse by intraperitoneal injection of anesthesia mix (100 mg/kg ketamine;
15 mg/kg xylazine; 1 mg/kg acepromazine). Perform a toe pinch test to ensure that the mouse is
fully anesthetized before commencing surgery.

2.1.2. Use a trimmer to shave the surgical area from below the chin towards the transversal
pectoral muscles.

2.1.3. Place the mouse in a supine position on a temperature-controlled surgery plate set to 37
°C. Secure the limbs with surgical tape and continuously monitor body temperature with a rectal
thermometer (Figure 2C). If body temperature drops below 37 °C cover the animal’s body with
sterile cotton gauze during surgery.

2.1.4. Apply eye ointment to protect the animal’s eyes during anesthesia.

2.1.5. Apply depilatory cream to the previously shaved surgical area. Remove hair and
depilatory cream using a cotton pad and warm water after 3-4 min. Make sure that the skin is
clean and free of any residual hair and depilatory cream, so that the wound will not be
contaminated during the operation.

2.1.6. Disinfect the skin with skin disinfection spray.

2.1.7. Place the animal under a dissecting microscope.

2.1.8. Make a 1-1.5 cm midline incision through the skin of the neck, startingimmediately below
the chin. Take effort to make the incision as straight as possible. (Figure 2D).
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NOTE: During the following steps, the surgical area must be kept moist by regular application of
sterile, warm (37 °C) 0.9 % NaCl.

2.1.9. Create a subcutaneous space at both sides of the incision by separating the skin from
underlying connective tissue with blunt dissection scissors. Be careful not to pinch the skin too
strongly with the forceps, as this can cause necrosis and lead to impaired wound healing after
surgery.

2.1.10. Separate the parotid and submandibular glands using cotton tip applicators to expose the
musculature overlying the trachea.

2.1.11. Retract the left salivary gland with curved dissection forceps to identify the left carotid
artery located laterally to the trachea (Figure 2E).

2.1.12. Carefully dissect the carotid artery from adjacent tissue using curved forceps. Be very
careful not to injure the vagal nerve that is running along the vessel. Continue blunt dissection to
expose the left carotid artery to about 10 mm in length and fully separate it from vascular fascia
and the vagus nerve (Figure 2F).

2.1.13. Pass a non-absorbable, 5-0 silk suture underneath the isolated portion of the carotid
artery while slightly lifting the blood vessel with curved forceps to reduce friction between the
sutures and the carotid artery, as this could easily damage the vascular wall.

2.1.14. Place the suture cranially, just proximally to the bifurcation of the carotid artery, form a
knot and tie it to permanently ligate the vessel (Figure 2G). Fix both ends of the cranial occlusion
suture to the surgery table with surgical tape.

2.1.15. Pass a second occlusion suture underneath the carotid artery and place it caudally at ~5
mm distance to the cranial suture (Figure 2H). It is needed for temporary occlusion of blood flow
during cannulation of the artery. Therefore, tie a loose knot and fix both suture ends with surgical
tape.

2.1.16. Position a third suture (secure suture) between the cranial and caudal occlusion suture
and make a loose knot (Figure 2l). This suture is needed to keep the catheter in place while
cannulating the artery. Tape the end of the suture to the surgery table.

2.2.  Cannulation of the left common carotid artery.

NOTE: The sensor area of the blood pressure catheter is located 4 mm from the distal end and
consists of a tube containing a non-compressible fluid and a biocompatible gel (Figure 2B). Since
this area is very sensitive, make sure it is free of air bubbles and do not touch it at any time during
the procedure.
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2.2.1. Bend the tip of a 24 G needle to an angle of ~100° to use it as a catheter introducer.

2.2.2. Gently pull the caudal occlusion suture and fix it with tension to temporarily stop blood
flow and to slightly lift the artery.

2.2.3. Carefully penetrate the artery proximal to the cranial occlusion suture with the bent
needle (Figure 2J). Grip the catheter with vessel cannulation forceps, introduce it into the small
puncture and let it slide slowly into the vessel. Gently pull back the bent needle simultaneously
(Figure 2K).

2.2.4. When the catheter reaches the caudal occlusion suture slightly tighten the secure suture
to keep the catheter in place (Figure 2L).

2.2.5. Loosen the caudal occlusion suture so that the catheter can be further moved until its tip
is positioned in the aortic arch.

NOTE: Be sure to determine the correct insertion length of the catheter, as this depends on the
size of the mouse. For male mice with a C57BL/6J background at 12 weeks of age and ~30 g body
weight, we recommend inserting the catheter until the integrated notch reaches the cranial
occlusion suture. The correct insertion depth and placement of the catheter for the specific
mouse line can be verified after euthanasia of the animal.

2.2.6. Once positioned properly, secure the catheter with all three sutures and cut the ends as
short as possible. Do not pull the knots too tight as this could damage the fragile blood pressure
catheter.

[Place Figure 2 here]

2.3.  Placement of the telemetry device body in a subcutaneous pocket on the left flank of the
mouse (Figure 3).

2.3.1. Form a subcutaneous tunnel from the neck directed towards the left flank of the animal
and form a small pouch using small, blunt dissecting scissors (Figure 3B).

2.3.2. lrrigate the tunnel with a 1 mL syringe filled with warm, sterile 0.9% NaCl solution and
introduce ~300 pL of the solution into the pouch (Figure 3C).

2.3.3. Carefully lift the skin with blunt forceps and introduce the transmitter device body into
the pouch (Figure 3D). During this step, be very careful not to pull the blood pressure catheter
out of the carotid artery.

2.4. Placement of the ECG leads in Einthoven Il configuration.

2.4.1. Form a thin tunnel to the right pectoral muscle with blunt dissecting scissors and place
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the negative (colorless) lead into the tunnel using blunt forceps. Fix the terminal end of the lead
with a stitch to the pectoral muscle using 6-0 absorbable suture material (Figure 3E).

2.4.2. Form a loop in the positive (red) lead, position its tip at the left caudal rib region and
secure its position with a suture using 6-0 absorbable suture material.

NOTE: It is important that both leads lie flat against the body for their whole length to avoid tissue
irritation (Figure 3F).

2.4.3. Close the skin with single knots using 4-0 non-absorbable suture material (Figure 3H).
Additionally, apply a small amount of tissue adhesive on every knot to keep the animal from

biting the suture and prevent dehiscence.

2.4.4. Apply povidone-iodine hydrogel 10% to the wound to prevent wound infection during the
recovery phase.

2.4.5. For preemptive pain relief inject 5 mg/kg carprofen in 0.9 % NaCl subcutaneously while
the mouse is still under anesthesia.

2.4.6. Set a heating platform to 39 + 1 °C and place the mouse in a separate housing cage.
Position one half of the cage on the platform for 12 h after surgery and transfer the mouse in the
warm area. When the animal awakens from anesthesia, it has the option of staying in the warm
area or moving to the cooler part of the cage.

[Place Figure 3 here]

2.5. Post-operative care

2.5.1. For post-operative pain relief inject 5 mg/kg carprofen in 0.9% NaCl subcutaneously every
12 h for 3-5 days until the wound has healed.

2.5.2. Inject 10 uL/g of warm ringer-lactate solution intraperitoneally to protect the animal from
dehydration.

2.5.3. Let the mice recover for 2-3 weeks before running the first telemetric measurements.
Carefully monitor general health conditions, wound healing, body weight, and food and water
intake during the recovery period.

2.5.4. At the end of the experiment, euthanize the mouse by carbon dioxide (CO3) inhalation.

NOTE: Cervical dislocation or decapitation is not recommended as euthanasia method since this
could damage parts of the ECG and BP transmitter device.

2.6.  Data acquisition.
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2.6.1. Take measures to avoid acoustic and electronic noise during data recording. Additionally,
limit access of personnel during data recording and complete all husbandry procedures prior to
the experiment.

2.6.2. Place the animal’s cage on the telemetry receiver plate and turn on the telemetric
transmitter by bringing a magnet close to the animal.

2.6.3. Acquire continuous ECG, blood pressure and activity recordings over 72 h (12-h dark/light
cycle) with data acquisition software (Figure 4).

2.7.  Analysis of the circadian rhythm of heart rate, blood pressure and activity.

2.7.1. Check the presence of a regular circadian rhythm of HR, BP and activity using data
acquisition software!? (Figure 5).

2.8. Data analysis including determination of baroreceptor sensitivity using the sequence
method with ECG and BP analysis software.

2.8.1. Export BP and HR data from data acquisition software into ECG and BP analysis software
(Supplemental File 2). Use the following sequence of commands: Open ECG and BP analysis
software > File > Raw data from converter > Convert non-l0OX raw data. In the new window click
File > Load Dataquest ART4 data. Again, a new window will open, select data file for export >
New window opens, select animal from “subjects” list and select ECG and BP from “waveforms
list” and press OK. Choose animals from which data should be converted by clicking Convert data
> Create 10X binary site file.

2.8.2. Open IOX binary site file in ECG and BP analysis software by using the following sequence
of commands: File > Load IOX data > Select BP and ECG trace > press the green checkmark.

NOTE: The following data processing parameters are optimized for data acquired from wildtype
mice and should in principle fit all mouse models used in preclinical field. However, adaption of
these parameters might be necessary when working with specific experimental models, e.g.,
mice with extremely high or low HR and/or BP values, or different rodent species. In any case,
data processing parameters need to be carefully reviewed to assure that they fit the specific
model under study.

2.8.3. For settings for ECG, BP and BRS analysis see Supplemental File 3,4). For BRS analysis in
mice, adjust the BRS parameters to detect only sequences of three (or more) beats exhibiting a
delay between SBP and RR of one beat, and set the threshold for SBP and RR change to 0.5 mmHg
and 2 ms. Ensure that the correlation coefficient of the slope of the regression line from RR/SBP
plots is larger than 0.75 and analyze only sections exhibiting stable sinus rhythm. Set parameters
for ECG, BP and BRS analysis accordingly by using the following sequence of commands: Tune >
analysis settings > new window opens
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2.8.3.1. ECG settings (right-click in the “ECG mode and signal filtering” window
(Supplemental File 3). Set the parameters as detailed here. Mode: ECG, RR-only, Filter mode:
auto, according to set HR, Expected heart rate: bpm > 300, Baseline removal filter width (ms):
100.00, Noise removal filter width: 1.00 ms, Notch filter: 50.0 Hz, Spike removal filter: off, Drop-
out detection mode: off, Max RR lengths (ms): 900.00, RR from adjusted R peaks: off, RR_only
settings mode: Xsmall: mouse, R peak width (ms): 10.00, PR width (ms): 20.00, RT width (ms):
50.00, Max inter beat artefact (%): 50.00, R to other amplitude ratio: 3.00, R peak sign: positive,
and Compute extra parameter: off

2.8.3.2. For the Blood pressure (BP, Pressure settings) right-click at the “BP analyzer”
window (Supplemental File 4). Set the parameters as detailed here. Noise removal filter width
(ms): 10.00, Derivative filter width (ms): 6.00, Notch filter: 50.0 Hz, Spike removal filter: off,
Validation threshold (cal. unit): 12.00, Rejection threshold (cal. unit): 8.00, Derivative at begin
upstroke (cal U/s): 10.00, Rejection limits: off, Delay from reference ecg: user defined window,
Min delay from ecg Rpeak (ms): 10.00, Max delay from ecg Rpeak (ms): 250.00, Conduct_time_1
from mark: not computed, Conduct_time_2 from mark: not computed, BR (breathing rate): off,
BRS (Baroreflex sensitivity): on, Minimum consecutive beat number: 3, Latency beat number: 1,
Pressure value: SBP, Mark to compute pulse interval: R, Minimum pressure variation (calU): 0.50,
Minimum interval variation (ms): 2.00, Minimum correlation: 0.75

2.8.4. Screen the activity signal for a 3-h sequence with low activity. Perform the BRS analysis in
this time window since high activity of the animals interferes with BP and RR correlation.

2.8.5. Perform a BP and RR analysis during this 3-h time window while subdividing the 3-h
analysis into 10 min steps.

2.8.6. Perform BRS analysis by using the following sequence of commands: Open BRS analysis
window > View > BRS analysis. This opens the BRS analysis panel. Manually inspect every
sequence displayed in the BRS analysis panel and exclude ectopic beats, sinus pauses, arrhythmic
events or noisy data. Make sure to invalidate every single beat of such sequences to successfully
exclude them from the analysis.

2.8.7. Export the results of the BRS analysis into a spreadsheet file (Results File). Modify the
parameters that are exported to the spreadsheet file by using the following sequence of
commands (Supplemental Files 5-7):

2.8.7.1. Tune > Parameters in list/to file > sections > txt (Supplemental File 5). Select the
“beats” section and any other section containing information of interest except the invalidated
beats section.

2.8.7.2. Tune > Parameters in list/to file > steps > txt (Supplemental File 6). Choose step
values to be exported.
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2.8.7.3. Tune > Parameters in list/to file > beats -> txt (Supplemental File 7).

2.8.7.4. Make sure that the beats section of the file contains at least the following data for
every single beat. ECG_RR, ECG_HR, BP_SBP, BP_BRS_deltaP, BP_BRS_# (=consecutive beat
intervals of the sequence), BP_BRS_slope, BP_BRS_correl, BP_BRS_shiftl (=RR of the subsequent
beat)

2.8.7.5. Then click File > Save results file.

2.8.8. Sort the exported data for up and down sequences using the filter function of Excel
(Supplemental File 8). Calculate the number of sequences, mean BRS slope, standard deviation
and standard error of BRS slope for up and down sequences separately. Also calculate the total
amount of sequences per 1000 beats.

NOTE: A spreadsheet template (TemplateBRS) for automated sorting and analysis of up and down
sequences is provided in the Supplement (Supplemental File 8) and facilitates the analysis. By
adjusting the filter function, you can sort sequences by different beat numbers (e.g., three- or
four-beat sequences). For further details see Supplemental files 9-13.

2.8.8.1. Open the Results File and the TemplateBRS Excel file (Supplemental File 8). Copy
the data of the following columns from the Results File: (Pressure) BRS deltaP,
(Pressure)_BRS_# and (Pressure) BRS_slope (Supplemental File 9). Paste the data into the
respective columns of the “Up sequences” and “Down sequences” spreadsheets in the
TemplateBRS file (Supplemental File 10). Additionally, copy the data of the column
(Pressure)_BRS_SBP from the Results File (Supplemental File 11) and paste it into the “All
sequences” spreadsheet in the TemplateBRS file (Supplemental File 12).

NOTE: the number in the (Pressure) _BRS_# column is listed only at the last beat of a sequence
and depicts the sequence length. Up and down sequences can be distinguished by the sign of the
(Pressure)_deltaP value. Negative values for the second and third beat of a three-beat sequence
indicate a down sequence. Positive values indicate an up sequence, respectively.

2.8.8.2. Filter the copied data with the default filter settings. Click on the filter icon of the
(Pressure)_BRS_# column and press “ok” (Supplemental File 13). Apply this step to the “Up
sequences” and “Down sequences” spreadsheets.

NOTE: the spreadsheet filters for three-beat sequences. If other sequence lengths are requested
the setting of this column has to be changed in the drop-down menu. Calculations for number of
sequences, mean BRS slope, standard deviation and standard error of BRS slope are displayed in
the green boxes of the “Up sequences” and “Down sequences” spreadsheets. Calculations for
the total number of sequences per 1000 beats appear in the green box of the “All sequences”
spreadsheet.
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REPRESENTATIVE RESULTS:

Positive results for ECG and BP raw data

Using this protocol high-quality ECG and BP data can be acquired (Figure 4 and Supplemental
File 14), allowing not only for precise BRS analysis but also for analysis of a broad range of ECG
or BP-derived parameters, e.g. ECG intervals (Figure 4B, upper panel), blood pressure parameters
(Figure 4B, lower panel), heart rate and blood pressure variability, arrhythmia detection etc!?1°,

[Place Figure 4 here]

Positive results for circadian rhythm

A healthy mouse that has sufficiently recovered from surgery shows a physiological increase of
activity, HR and BP during the activity (dark) phase (Figure 5). Many different factors can disturb
this regular circadian rhythm. These include psychological stress, acoustic or electric noise and
pain. For example, an acute pain condition immediately after surgery would result in an increase
in heart rate with a simultaneous decrease in activity. Therefore, the circadian rhythm is an
important indicator for animal health and well-being and should be routinely checked before BRS
analysis.

[Place Figure 5 here]

Positive results for BRS analysis

After performing the analysis as described in the protocol section 2.8 the software will detect up
and down sequences, respectively. The method used is called sequence method since changes in
SBP and RR intervals are examined on a beat-to-beat basis during short sequences of three or
more beats with a spontaneous rise or fall in SBP (Figure 6). A continuous elevation in SBP over
three heartbeats causes a reflex increase in parasympathetic activity and in consequence slows
down HR, which is equivalent to longer RR intervals. The latency for the reflex HR adaption is one
beat. Such a sequence is shown in Figure 6A and is defined as an up sequence. In contrast, a
continuous decrease in SBP over three beats with parallel rise in HR (decrease in RR interval) is
defined as a down sequence (Figure 6B). To evaluate the correlation between RR and SBP, both
parameters are plotted against each other and the slope (ms/mmHg) of the linear regression line
is calculated for each sequence (Figure 6A,B, lower panels). After sorting by up and down
sequences the average number of up and down sequences per 1000 beats (Figure 6C) and
average gain of spontaneous BRS can be calculated for up and down sequences, respectively
(Figure 6D,E). The gain of spontaneous BRS is reflected by the slope of the linear regression line
calculated from the RR/SBP relation. The deviation from normal BRS values can have various
causes. These include changes in ANS input or changes in the responsiveness of the sinoatrial
node to autonomic nervous system input. In Figure 6 increased BRS in a mouse model for sick
sinus syndrome (SSS) with exaggerated responsiveness of the sinoatrial node to vagal input is
shown??,
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[Place Figure 6 here]

Negative result for raw data quality

Especially during phases of higher activity signal quality might decrease (Figure 7 and
Supplemental Files 15,16). This can be caused by temporary displacement or incorrect position
of either the BP catheter or ECG leads or both due to motion of the animal. Also, skeletal muscle
activity might be detected from the ECG leads and induce noise (Figure 7B, upper panel). With
the software settings described above, these low quality beats are not detected and are
therefore excluded from analysis. Nevertheless, manual inspection of the analysed raw data is
mandatory.

[Place Figure 7 here]

Negative results for BRS analysis

The BRS analysis settings listed in protocol section 2.8.3 are in general essential for fast and
correct detection of up and down sequences. The minimum correlation coefficient for the
regression line is set to 0.75. Setting too low values for the minimum correlation coefficient
results in false detections of sequences that do not reflect baroreflex activity but rather result
from arrhythmic beats (Figure 8). For BRS analysis only episodes with stable sinus rhythm must
be analysed. Ectopic beats or other arrhythmic events, e.g., sinus pauses, can be found with the
HRV option of ECG and BP analysis software and must be invalidated.

[Place Figure 8 here]

FIGURE AND TABLE LEGENDS:

Figure 1: Schematic representation of the baroreflex and baroreflex sensitivity assessment
using the sequence method. (A) Course of the baroreflex during an acute increase in blood
pressure. A short-term rise in ABP is sensed by baroreceptors located in the aortic arch and
carotid sinus. This information is transmitted to the central nervous system and induces a
decrease in sympathetic nerve activity in parallel with an increase in parasympathetic activity.
Release of acetylcholine from nerve endings located in the sinoatrial node region induces a
decrease of the second messenger cAMP in sinoatrial node pacemaker cells and hence a
reduction in heart rate. A short-term decrease in blood pressure has the opposite effect. (B)
Schematic BP traces during an up sequence (upper left panel) and down sequence (upper right
panel) of three consecutive beats. An up sequence is associated with a parallel increase in RR
intervals (lower left panel) which is equivalent to a decrease in HR. A down sequence is associated
with a parallel decrease in RR intervals (lower right panel) which is equivalent to an increase in
HR.

Figure 2: Implantation of a combined ECG and blood pressure transmitter - cannulation of the
left carotid artery. (A) The telemetry transmitter is composed of a pressure catheter, two
biopotential electrodes and the device body. (B) Schematic representation of the pressure
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catheter. The sensor area consists of a non-compressible fluid and a biocompatible gel. The
cranial occlusion suture of the carotid artery must be attached to the notch of the catheter to
ensure proper position in the blood vessel. (C) Anesthetized C57BL/6J mouse prepared for
surgical transmitter implantation. (D-L) Image sequence showing surgical procedure for
cannulation of the left carotid artery. (D) Cervical skin incision. (E) Exposed trachea to identify
the left carotid artery located laterally to the trachea. (F) Blunt dissection to isolate the artery
from adjacent tissue and the vagus nerve. (G) Permanent ligation of the left carotid artery with
cranial occlusion suture. (H) Tension applied to caudal occlusion suture to temporarily stop blood
flow. (1) Secure suture to keep the catheter in place during cannulation. (J) Cannula with curved
tip for insertion of the catheter into the blood vessel. (K) Pressure catheter is inserted into the
carotid artery. (L) The catheter tip is positioned in the aortic arch and secured with the middle
suture. Scale bar in D — L shows 4 mm. Reprinted from?®.

Figure 3: Implantation of a combined ECG and blood pressure transmitter - subcutaneous
placement of the ECG electrodes and device body. (A) Mouse after insertion of the blood
pressure catheter. Catheter position is secured by the occlusion sutures. (B) Forming a
subcutaneous pocket on the left flank of the animal with blunt scissors. (C) The pouch is irrigated
with 1 mL of warm sterile saline. (D) The device body is placed in the subcutaneous pocket. (E)
The terminal end of the negative electrode (colorless) is fixed to the right pectoral muscle with
absorbable suture material. (F) Fixation of the positive electrode (red) to the left intercostal
muscles. (G) Placement of a permanent suture on the chest muscle to secure the position of the
ECG electrodes. (H) Mouse after skin closure. The subcutaneous positions of the ECG electrode
tips are indicated by red circles. Reprinted from?®.

Figure 4: Telemetric ECG and BP recordings. (A) Representative, high-quality ECG trace (upper
panel) and corresponding high-quality raw BP recordings (lower panel). (B) Magnification of ECG
traces (upper panel). P wave, QRS complex, T wave and RR interval are indicated. Magnification
of corresponding BP data (lower panel). Diastolic BP (DBP) and systolic BP (SBP) are indicated.

Figure 5: Analysis of long-term telemetry measurements to determine circadian rhythm
variations. Circadian rhythm of heart rate (A), activity (B), systolic blood pressure (C) and diastolic
blood pressure (D) averaged from 9 male wild-type C57BL/6J mice during 12 h light and dark
cycles. Grey areas depict the activity (dark) phase and white areas depict the resting (light) phase
of the animals. All parameters are physiologically elevated during the animal’s activity (dark)
phase. Data are represented as mean +/- SEM.

Figure 6: Estimation of BRS using the sequence method. (A) Representative BP trace of a wild-
type C57BL/6J mouse during an up sequence of three consecutive beats (upper panel) associated
with a parallel increase in RR interval (middle panel) which is equivalent to a decrease in HR. The
RR intervals were plotted against the SBP (lower panel). The slope of the regression line (red line)
for the up sequence depicted in the upper and middle panel (WT, black circles) was 4.10
ms/mmHg. A representative RR/SBP relationship of the sick sinus syndrome mouse model
yielded an increased slope of 6.49 ms/mmHg indicating elevated BRS (SSS, grey circles). (B)
Representative down sequence of a wild-type mouse with a drop in SBP (upper panel) and a
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subsequent decrease in RR interval (middle panel) which results in a BRS slope of 4.51 ms/mmHg
(lower panel; WT, black circles). A representative RR/SBP relationship of the sick sinus syndrome
mouse model (SSS, grey circles) with a slope of 7.10 ms/mmHg. The orientation of the red
arrowheads indicates the direction of the sequences (up or down sequence). (C) Total amount of
sequences per 1000 beats for WT and SSS mice. (D) Mean slope of the RR/SBP relationship for up
sequences for WT and SSS mice. (E) Mean slope of the RR/SBP relationship for down sequences
for WT and SSS mice. Statistics in (C-E) were performed from results of six male WT animals and
eight male animals of the sick sinus syndrome mouse model. Boxplots show the median line, perc
25/75, and min/max value; open symbols represent the mean value.

Figure 7: Examples of low-quality raw signals. (A) ECG signal (upper panel) is detected with good
quality, but BP signal (lower panel) quality is low. (B) Qualities of ECG (upper panel) and BP (lower
panel) signal are not sufficient.

Figure 8: Sequences that do not reflect baroreflex activity. (A) ECG trace of a mouse with mild
sinus dysrhythmia. (B) BP recording depicting a spontaneous increase in SBP. (C) Corresponding
RR intervals indicate a decrease of HR upon the increase of BP. (D) Plot of SBP and corresponding
RR intervals. The low correlation coefficient of the regression line indicates that HR reduction
was not caused by activity of the baroreflex but rather by sinus dysrhythmia. (E) Raw ECG trace
depicting a sinus pause. (F) Corresponding raw BP signal. The sinus pause causes a drop in
diastolic blood pressure. Systolic blood pressure of the subsequent beat is almost unaffected.

Supplemental File 1: Surgery protocol. Template for documentation of the surgical procedure
and post-operative care.

Supplemental File 2: Converting Dataquest A.R.T data into 10X data for analysis in ecgAUTO
software. Select animals in the subjects list (left) and Pressure and ECG in the waveforms list
(right). Press OK to convert data.

Supplemental File 3: ECG settings for BRS analysis. Set parameters as listed, press ok and apply
the configuration.

Supplemental File 4: BP settings for BRS analysis. Set parameters as listed, press ok and apply
the configuration. Save the configuration as a configuration file to be able to load the settings
easily.

Supplemental File 5: Parameters in list/to file window for “sections”. Choose sections to be
exported under the sections > txt header (selected) and press Apply!.

Supplemental file 6: Parameters in list/to file window for “steps”. Choose step data to be
exported under the steps > txt header (selected) and press Apply!.

Supplemental File 7: Parameters in list/to file window for “beats”. Choose values to be exported
under the beats > txt header (selected) and press Apply!. For BRS analysis the ticked parameters
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are necessary. Note the order of selection indicated by the numbers.

Supplemental File 8: TemplateBRS spreadsheet file. Spreadsheet template for automated
sorting and analysis of up and down sequences.

Supplemental File 9: Copying relevant data from the Results File I. Copy the columns
(Pressure)_BRS_deltaP, (Pressure)_BRS_# and (Pressure) BRS_slope from the Results File.

Supplemental File 10: Spreadsheet template file (TemplateBRS) for data sorting and analysis I.
Paste the copied data into the respective columns of the “Up sequences” and “Down sequences”
spreadsheet in the TemplateBRS spreadsheet file.

Supplemental File 11: Copying relevant data from the Results File Il. Copy the column
(Pressure)_BRS_SBP from the Results File.

Supplemental File 12: A spreadsheet template file (TemplateBRS) for data sorting and analysis
Il. Paste the copied SBP data into the “All sequences” spreadsheet in the TemplateBRS
spreadsheet file to calculate the total number of sequences.

Supplemental File 13: Filtering and analyzing the sequences. In the “Up sequences” spreadsheet
of the TemplateBRS spreadsheet file, open the drop-down menu of the (Pressure) BRS_# column
filter and press OK without changing any parameters. This will automatically sort the data and
update the calculations for sequences with 3 beats. Repeat this for the “Down sequences”
spreadsheet.

Supplemental File 14: Screenshot of a high-quality recording detected with ECG and BP analysis
software. The upper trace (ECG) shows detection of each R-peak and the lower trace (BP) shows
detection of each diastolic pressure (DP) and systolic pressure (SP) peak. Areas under successfully
detected peaks are marked in red.

Supplemental File 15: Screenshot of a low-quality BP recording where BP parameters are only
partially detected. The upper trace (ECG) shows detection of each R-peak but the lower trace
(BP) shows gaps between detected BP peaks. Detected peaks of diastolic pressure (DP) and
systolic pressure (SP) are marked with red areas.

Supplemental File 16: Screenshot of a low-quality ECG and BP recording where ECG and BP
parameters could not be detected. The upper trace (ECG) shows a region (purple background)
where ECG parameters could not be detected. BP detection (lower trace) also failed due to low
signal quality.

DISCUSSION:

Significance of the method with respect to alternative methods
In the present work, we present a detailed protocol to quantify spontaneous BRS using the
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sequence method. This approach utilizes spontaneous BP and reflex HR changes measured by
ECG and BP telemetry. The advantage of this method is that both parameters can be recorded in
conscious, freely moving, unrestrained animals without disturbing animals by walking into the
room where the measurements are performed or even by physical interaction required for
injection of drugs. This point is very important since it has been clearly shown that such
disturbances severely interfere with HR and BP recordings. For example, the injection of drugs
requires fixation of the mice, which causes a maximum stress response that increases HR up to
650-700 bpm. To circumvent these stress responses, BRS has been previously determined in
anesthetized mice. However, standard anesthetics used in veterinary medicine such as
ketamine/xylazine or isoflurane induce bradycardia and influence autonomic reflex responses,
limiting the validity of these approaches and the interpretation of the results. To partially
overcome these limitations implantable drug delivery devices, i.e., osmotic pumps, which can
release drugs into the peritoneal cavity were used. However, with osmotic pumps it is not
possible to apply a bolus of a defined dose of drug limiting the application of such devices.
Alternatively, complex infusion catheters!’ can be implanted into mice in order to administer
drugs. However, these catheters are difficult to handle and require surgical skills comparable to
those required for the implantation of telemetric devices, while producing less scientific outcome
as compared to measurements of spontaneous BRS. Beside the technical issues associated with
measuring BRS using injection of drugs, there are some limitations related to the drug action per
se. Traditional approaches for determining BRS include bolus injections of vasoactive drugs.
However, bolus injection of vasoconstrictors (e.g., phenylephrine) or vasodilators (e.g., sodium
nitroprusside) have been considered an excessive and non-physiological stimulus for reflex HR
adaption to changes in BP*. Spontaneous activity of the baroreceptor reflex can also be
guantified using spectral methods. One of these methods assesses BRS in the frequency domain
by calculation of the ratio between changes in HR and changes in blood pressure in a specific
frequency band'®1%, Other spectral methods involve the determination of the transfer function
of BP and HR or the quantification of the coherence between BP and HR?%?1, These methods also
require telemetric acquisition of spontaneous BP and HR parameters and while they are
appropriate for the determination of spontaneous BRS, they require intensive computational
tools and are challenging to apply. Furthermore, all spectral methods suffer from the limitation
that non-stationary signals preclude the application of spectral methods. In particular, spectral
peaks induced by respiration rhythms can be reduced in human patients by asking the patient to
stop breathing, while this is obviously not possible in mice. Therefore, the signal-to-noise ratio is
frequently quite low in mice. Given the limitations of the methods discussed above, we favor the
sequence method for determining BRS in mice. A considerable advantage of this method is the
fact that it is a noninvasive technique that provides data on spontaneous BRS under real life
conditions??. One further important point is that the duration of sequences analyzed using the
sequence method are quite short, involving 3-5 beats. Reflex regulation of HR by the vagal nerve
is very fast and well within the timeframe of these sequences. Therefore, the sequence method
is well suited to evaluate the contribution of the vagal nerve to BRS. By contrast regulation by
the sympathetic nervous system is much slower. In fact, during these short sequences activity of
the sympathetic nervous system can be assumed to be almost constant. Therefore, the method
is customized to selectively detect reflex changes of the HR driven by vagus nerve activity.
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Interpretation of BRS data

For the interpretation of BRS dysfunction or BRS data per se it is important to consider the
individual functional levels which are involved in the baroreceptor reflex. On the neuronal level,
afferent, central or efferent components of the reflex might be affected?3. On the cardiovascular
level, reduced or exaggerated responsiveness of the sinoatrial node to ANS input might be
present!?4. A change on each level could lead to changes in the BRS. In order to dissect whether
neuronal and/or cardiac mechanisms are responsible for observed changes in BRS, cardiac or
neuron specific gene deletion, knock down or gene editing approaches could be used.

Critical steps in the protocol

The most sophisticated and critical step in this protocol is the preparation and cannulation of the
left carotid artery (Step 2.2). The tension of the caudal occlusion suture has to be sufficiently high
to completely stop the blood flow before cannulation. Otherwise, even a small leakage of blood
during cannulation can severely restrict visibility or even cause the mouse to bleed to death.
Cannulation should be successful at the first attempt. However, upon failure of the first attempt,
it is still possible to carefully retry cannulation.

The midline incision and subcutaneous tunnel from the neck to the left flank (Step 3.2) must be
large enough to easily introduce the transmitter without force but must also be as small as
possible to keep the transmitter in place. Otherwise, one will need to lock it into position with
suture material or tissue adhesive. Since mice have a very delicate skin, necrosis of the skin can
occur if the tunnel for the transmitter is too small.

If the ECG electrodes are too long to fit into the subcutaneous tunnel (Step 2.4), it is necessary
to form a new tip by shortening the electrode to a proper length. The electrode must lie flat
against the body over the entire length of the lead. Too long electrodes will disturb the animals
and they will try to open the wound to remove the transmitter, resulting in risk of tissue irritation
and wound dehiscence. Leads that are too short can of course not be extended and it may be
that in this case the electrodes cannot be positioned in such a way that they correspond to
Einthoven Il configuration. We, therefore, recommend, to determine the optimal length of the
ECG leads on a dead mouse of the same sex, weight, and genetic background.

Mice should be given a longer recovery time after transmitter implantation if they do not have a
normal circadian rhythm and this is not the phenotype of the mouse line under study (step 2.7).
Another reason for disturbed circadian rhythms could be inadequate acoustic isolation of the
animal facility or personnel entering the room during measurement.

ECG, BP and BRS data analysis is straight forward (Step 2.8). The most critical step is to exclude
ectopic beats, sinus pauses, arrhythmic episodes or sections with low-quality signals from data
analysis.
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Table of Materials

Name of Material/ Equipment
Acepromazine maleate (Tranquisol KH)
Solution Injectable 0.5 mg/mL

B.Braun Injekt-F 1 mL syringe
Bepanthen eye and nose ointment
Blunt dissecting scissors

Carprofen (Carprosol) 50 mg/mL

Cutasept F skin desinfectant

Cotton Tipped Applicator sterile
Forceps - Micro-Blunted Tips

Forceps - straight

Gauze swabs wit cut edges, 7.5x7.5 cm,
cotton

HD-X11, Combined telemetric ECG and BP
transmitters

Homothermic blanket system with flexible
probe

Hot bead sterilizer
Ketamine 10%
Magnet

Needle holder, Olsen-Hegar with suture
cutter

Needle single use No. 17, 0.55 x 25 mm

Click here to access/download;Table of Materials;Table of Materials.xls

Company Catalog Number
CP-Pharma, Germany 1229
Wolfram Droh GmbH, Germany 9166017V

Bayer AG, Germany
Fine Science Tools GmbH,

14078-10

Germany
CP-Pharma, Germany 115
BODE Chemie GmbH, Germany 9803650
Paul Boettger GmbH & Co. KG, 09-119-9100
Germany
i .

ine Science Tools GmbH, 11253-25
Germany
Fine Science Tools GmbH, 11008-13
Germany
Paul Hartmann AG. Germany 401723
Data Sciences International,
United States
Harvard Apparatus, United States
i .

ine Science Tools GmbH, 18000-45
Germany
Ecuphar GmbH, Germany 799-760
Data Sciences International,
United States
Fine Science Tools GmbH, 12502-12
Germany
Henke-Sass Wolf GmbH, 4710005525

Germany

*
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Needle single use No. 20, 0.40 x 20 mm
Needle-suture combination, sterile,
absorbable (6-0 USP, metric 0.7, braided)

Needle-suture combination, sterile, silk (4-0
USP, metric 1.5, braided)
OPMI 1FR pro, Dissecting microscope

Pilca depilatory mousse
PVP-lodine hydrogel 10%

Ringer lactat solution

Sensitive plasters, Leukosilk

Sodium chloride solution 0.9% sterile
Miniplasco Connect 5 ml

Surgibond tissue adhesive

Suture, sterile, silk, non-needled (5-0 USP,
metric 1 braided)

Trimmer, Wella Contura type 3HSG1

Vessel Cannulation Forceps

Xylazine (Xylariem) 2%

Data acquisition and analysis

DSI Data Exchange Matrix
DSI Dataquest ART 4.33
DSI Ponemah

DSI PhysioTel HDX-11 for mice

Henke-Sass Wolf GmbH,
Germany

Resorba Medical, Germany

Resorba Medical, Germany

Zeiss, Germany

Werner Schmidt Pharma GmbH,

Germany

Ratiopharm, Germany

B. Braun Melsungen AG,
Germany

BSN medical GmbH, Germany

B. Braun Melsungen AG,
Germany
SMI, Belgium

Resorba Medical, Germany

Procter & Gamble

Fine Science Tools GmbH,
Germany

Ecuphar GmbH, Germany

Source

Data Sciences International,
United States

Data Sciences International,
United States

Data Sciences International,
United States

Data Sciences International,
United States

4710004020

PA10273

4024N

6943151

401-951

102100

2G2

G2105

18403-11

797469



DSI PhysioTel receivers RPC1

ecgAUTO v3.3.5.11

Microsoft Excel

Data Sciences International,
United States

EMKA Technologies

Microsoft Corporation, United
States
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preemptive and post-operative pain relief

anesthesia

transmitter turn on/off

24 G needle



27 G needle

lead fixation

skin closure

surgical tape

lead preparation, ligation sutures

anesthesia

data aquisition software

data aquisition software



ECG and BP analysis software
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Editorial comments:

Changes to be made by the Author(s):

1. Please take this opportunity to thoroughly proofread the manuscript to ensure
that there are no spelling or grammar issues. Please define all abbreviations
at first use.

We have thoroughly proofread the manuscript and all supplemental files to ensure that
there are no grammar and spelling issues. We defined all abbreviations at first use.
We have made all corrections in the track changes mode.

2. Please revise the following lines to avoid overlap with previously published
work: 185-188, 242 (position..)-245, 392 (The applied methods...)-396 (..HR);
397 (This kind...)-401 (...sequence), Figure 2 and 3 legends, 578-581
(..alterations), 625-628, 633-6363.

We have revised the specified sections to avoid overlap with previously published
work.

3. JOVE cannot publish manuscripts containing commercial language. This
includes trademark symbols (™), registered symbols (®), and company
names before an instrument or reagent. Please remove all commercial
language from your manuscript and use generic terms instead. All
commercial products should be sufficiently referenced in the Table of
Materials and Reagents. For example: Dataquest A.R.T software, ecgAUTO
software etc.

We did remove commercial language from the manuscript.

4. Being a video based journal, JOVE authors must be very specific when it
comes to the humane treatment of animals. Regarding animal treatment in the
protocol, please add the following information to the text: please specify the
euthanasia method, but do not highlight it. Similarly, please do not highlight
anesthesia steps.

We now specify the euthanasia method in step 2.5.4. It now reads: At the end of the
experiment, euthanize the mouse by carbon dioxide (CO2) inhalation. Note: we do not
recommend cervical dislocation or decapitation as euthanasia method since this could
damage parts of the ECG and BP transmitter device.

5. Please ensure that all text in the protocol section is written in the imperative
tense as if telling someone how to do the technique (e.g., “Do this,” “Ensure
that,” etc.). The actions should be described in the imperative tense in
complete sentences wherever possible. Avoid usage of phrases such as
“could be,” “should be,” and “would be” throughout the Protocol. Any text
that cannot be written in the imperative tense may be added as a “Note.”
However, notes should be concise and used sparingly. Please include all
safety procedures and use of hoods, etc.

I+
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We have made the changes as requested and now use the imperative tense
throughout the manuscript.

6. Please note that your protocol will be used to generate the script for the video
and must contain everything that you would like shown in the video. Please
add more details to your protocol steps. Please ensure you answer the “how”
guestion, i.e., how is the step performed? Alternatively, add references to
published material specifying how to perform the protocol action. Please add
more specific details (e.g., button clicks for software actions, numerical
values for settings, etc) to your protocol steps. There should be enough detail
in each step to supplement the actions seen in the video so that viewers can
easily replicate the protocol.

We added more details to the protocol steps and made the changes as requested. We
have already completed the video of the surgery (Supplemental Video 1).

7. Please specify which mouse strain was used here. Do you mean C57B/L67

For the production of the video and the illustrations, as well as for the generation of the
representative data, we used mice of the C57BL/6J mouse strain.

The animals of the sick sinus syndrome mouse model (Hcn4im3(Y527FRE69E,T670A)Biel)
displaying increased BRS sensitivity were maintained on a mixed C57BL/6N and
129/SvJ background (Fenske S., Nat Commun, 2020).

We now provide this information in the manuscript as a “Note” at the beginning of the
Protocol section.

8. Pleaseinclude aone line space between each protocol step and then highlight
up to 3 pages of protocol text for inclusion in the protocol section of the video.

We now include a one-line space between each protocol step. In addition, we have
highlighted in yellow all text passages that are shown in our video (Supplemental
video 1).

9. Please include a scale bar and define the scale in the Figure Legend for
Figure 2.

We added a scale bar to the images shown in Figure 2 D-L and we define the scale in
the Figure Legend for Figure 2 as follows: Scale bar in D-L shows 4 mm.

10. Please do not abbreviate journal names in the reference list.

We have corrected this accordingly. The journal names in the reference list are no
longer abbreviated.

11. Please provide timecodes or markers with the footage that correspond to the
script steps to aid our editors

We now provide a detailed time code (Supplemental file Timecode) to the script steps.



Reviewers' comments:

Reviewer #1:

Manuscript Summary: This paper aims to present a surgical technique for
implantation of an ECG and BP measurement device. Furthermore, they
described data processing procedure for assessment of baroreflex
sensitivity. The paper is well written and only few issues should be discussed
before considering it for publication in JoVE.

We would like to thank the reviewer for his/her positive feedback.
Major Concerns: None
Minor Concerns:

1) Section 2.8: parameters for data processing were extensively described.
However, it is not clear if these parameters can fit all rodents' models used in
preclinical field. In other words, some specific experimental models (as an
example, with physiological extremely high/low heartbeat and/or pressure
values) could require adaptation of these parameters to their specific
physiological features. Accordingly, authors should add a comment about the
need of carefully review data processing parameters in order to check that
they fit the specific model under study.

We agree with the reviewer and added the following passage to section 2.8:

“Note: the following data processing parameters are optimized for data acquired from
wildtype mice and should in principle fit all mouse models used in preclinical field.
However, adaption of these parameters might be necessary when working with specific
experimental models, e.g. mice with extremely high or low HR and/or BP values, or
different rodent species. In any case, data processing parameters need to be carefully
reviewed in order to assure that they fit the specific model under study.”

2) Section 2.8.8 and 2.8.9: sorting of data should be better described. In
particular, MATLAB code should be mandatory added. Furthermore, screen
capture of this processing step could be usefully added to the paper.

We now provide an Excel file in the supplement (TemplateBRS, Supplemental file 8)
to easily sort for up- and down-sequences by copying the data from the exported
Results File into it. We also provide screen captures containing a step-by-step
explanation on how to analyze data with the TemplateBRS Excel file (Supplementary
files 9-13) and we describe all corresponding steps in the protocol section of the
manuscript (section 2.8.7 — 2.8.8). Using Excel has two major advantages compared
to a MATLAB script. First, it is an inexpensive standard software available in every lab.
Second, it is easy to use even for the less experienced experimenter.



Reviewer #2:

Manuscript Summary: The paper describes a relatively novel way to determine
baroreceptor sensitivity using radio telemetry recordings of blood pressure
and ECG in mice. This approach will be useful for models of chronic disease
in genetic mouse models.

We would like to thank the reviewer for his/her positive feedback.
Major Concerns:

The paper would be stronger if it included a chronic model in which BRS
changes to better demonstrate the utility and sensitivity of this method. This
issue might also be addressed in the discussion.

We thank the reviewer for this suggestion to improve the manuscript. We have now
added BRS data from a mouse model with sick sinus syndrome. In this mouse model,
BRS sensitivity is significantly increased. For reference please see (Fenske S., Nat
Commun, 2020)

Minor Concerns:

It is not clear whether Dataquest ART is still available. Would a new be able to
do the same analysis with Ponemah software? This should be addressed.

We agree with the reviewer on this point. The Dataquest A.R.T. recording software
from DSI has been discontinued and replaced by the Ponemah software. But since
Dataquest A.R.T has been the gold standard software for decades it is still very
common and used in many labs, like ours. That is why we have described the protocol
using this software. Furthermore, the Ponemah raw data can similarly be imported into
the ecgAUTO analysis software for subsequent BRS analysis.

As the editor told us during the revision process to remove all trademarks and company
names from the manuscript, since JoVE does not publish manuscripts that contain
commercial language, we have now included Ponemah software in the “table of
materials and reagents” in the supplements as potential recording software.

References
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V. Mehlfeld, J. Brennan, I. R. Efimov, A. G. Pauza, M. Moser, C. T. Wotjak, C. Kupatt, R.
Gonner, R. Zhang, H. Zhang, X. Zong, M. Biel and C. Wahl-Schott (2020). "cAMP-dependent
regulation of HCN4 controls the tonic entrainment process in sinoatrial node pacemaker cells.”
Nat Commun 11(1): 5555.



Letter to the editor Click here to access/download;Supplemental File (Figures,
Permissions, etc.);Letter to the editor.pdf

LUDWIG-
MAXIMILIANS- DEPARTMENT PHARMAZIE-ZENTRUM FUR
LMU UNIVERSITAT PHARMAFORSCHUNG
MUNCHEN PHARMAKOLOGIE FUR NATURWISSENSCHAFTEN
Dept. Pharmazie-Zentrum f. Pharmaforschung - Butenandtstr. 7 - 81377 Miinchen Dr. Stefanie Fenske
Akademische Rétin, Apothekerin
Butenandtstr. 7
JoVE 81377 Miinchen
Nam Nguyen, Ph.D.
Manager of Review Telefon  +49 (0)89 2180-77140

Telefax ~ +49 (0)89 2180-77326
Stefanie.fenske@Imu.de

14.01.2021

Dear Dr. Nguyen,

We are pleased to submit our revised manuscript entitled "Implantation of combined telemetric
ECG- and blood pressure transmitters to determine spontaneous baroreflex sensitivity in
conscious mice (JoVE62101)".

We would like to thank you and the reviewers for the suggestions to improve our manuscript.
We carefully revised the manuscript and we feel confident that we addressed all the questions
and comments.

Since there is of course a backlog of video production due to the Corona Pandemic, we would
like to ask if the video that we have already completed for the surgery part can be put online

in the case of a positive review.

Yours sincerely,

- & /f@u-\féa

Stefanie Fenske

Dienstgebaude Offentliche Verkehrsmittel Bayerische Landesbank Minchen
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Chronological sequence

Time point

Action

Test start

Implantation of the telemetric blood pressure- and ECG-transmitter
Injection anesthesia:

15 mg/kg xylazine, 100 mg/kg ketamine, 1 mg/kg acepromazine i.p.
Medication under anesthesia:

Preemptive analgesia (carprofen 5 mg/kg BW s.c.)

From day 1 after surgery

Recovery phase after implantation: approx. 2 weeks

Postoperative analgesia: Carprofen 5 mg/kg bw s.c., every 12 hours
Day 1 after surgery: Carprofen 5 mg/kg BW s.c. (2 injections)

Day 2 after surgery: Carprofen 5 mg/kg BW s.c.(2 injections)

Day 3 after surgery: Carprofen 5 mg/kg BW s.c. (2 injections)

Day 4 after surgery: Carprofen 5 mg/kg BW s.c. (2 injections)

Day 5 after surgery: Carprofen 5 mg/kg BW s.c. (2 injections)

2-3 weeks after surgery

Basal blood pressure and ECG measurement
Duration of the measurement: 3 days

The day after the
measurement

Euthanasia and transmitter explantation

Total duration of
experiments after
implantation

2-3 weeks
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Test report part 1/2

Il. Implantation telemetric transmitter

Title of the animal protocol | Training display

File number of the animal Sex:
protocol:
Mouse line/ Genotype: Weight:

Mouse ID:

Experimenter:

Date of birth:

Signature:

Type of transmitter: | HD-X11

Transmitter-Nr:

Anesthesia:

Origin of animals:

Injection anesthesia:

15 mg/kg xylazine, 100 mg/kg ketamine, 1 mg/kg acepromazine i.p.

Conc. of the injection solution: pg/ul
Injection volume: uL
Time of injection: o'clock
Start of the operation: o'clock
Possibly ketamine injection pL
Time of injection: o'clock
End of surgery: o'clock
End of anesthesia: o'clock
Reawakening: Euthanasia: Euthanasia-reason:
Special remarks:
Medication under anesthesia:
Preemptive analgesia: | Carprofen 5 mg/kg BW s.c.

Conc. of the injection solution: pg/ul
Injection volume: pl

Dexpanthenol eye ointment/gel:
0.9% NaCli.p.: pL

Miscellaneous:




Test report part 2/2

Mouse strain / genotype:

Experimenter:

Mouse identification number:

Signature:

Observations under anesthesia: see anesthesia protocol

Other / Remarks:




Postoperative Analgesia

Mouse strain / genotype:

Experimenter:

Mouse identification number:

Signature:

Postoperative Analgesia:

Postoperative Analgesia:

Carprofen 5 mg/kg BW s.c., every 12 hours

Conc. of Injection solution: pg/ul
Day 1 after surgery:
Injection volume: pL Time of injections: o'clock
o'clock
If necessary, further measures:
Day 2 after surgery:
Injection volume: pL Time of injections: o'clock
o'clock
If necessary, further measures:
Day 3 after surgery:
Injection volume: pL Time of injections: o'clock
o'clock
If necessary, further measures:
Day 4 after surgery:
Injection volume: pL Time of injections: o'clock
o'clock
If necessary, further measures:
Day 5 after surgery:
Injection volume: pL Time of injections: o'clock
o'clock

If necessary, further measures:

Place, Date

Signature head investigator
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mode

fiter mode

expected HR

bazeline removal fitter width {ms}

noise remowval filtter width (ms)

notch fitter
spike removal fiter

drop-out detection mode

max RE lengths (mz)

RR from adjusted R peaks

¥ RR_onhy =ettings mode

PR width (ms)
RT width (ms)

max inter beat artefact (%)

ECG ; RR-only

auto, according to set HR

bpm = 300

= | S

100.00

|1.00
50 Hz
off
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1000
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Supplesnental Elaitgs. : lead 2 : GH4

noize removal fitter width (mz)

derivative filter width (m=)

notch fitter

spike removal fiter

validation threshold (cal unit)

rejection threshold (cal. unit}

derivative at begin upstroke (cal Uis)

Rejection limitz

delay from reference ecg user defined window

min delay from ecg Rpeak (ms) :|1|:|_|]|:|

max delay from ecg Rpeak (ms} :|25|]_|]|]

conduct_time_1 from mark : not computed

conduct_time_2 from mark : not computed

BR (breathing rate} :

BRS (Baroreflex sensitivity) :

minimum consecutive beat number

latency beat number

pressure value

mark to compute pulse interval

minmum pressure variation (call}

minmum interval variation (ms}

minimum correlation

cancel | ok |

— e
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opismental FilesGio fle 133511 3231 dromigsionp- |

L L e

| oK i
|

Apply!  Cancel! Cancel & close! Help! Print!

main table I report table I comment table {  gections ->bd I steps - te beats -= bt I statistics precision HRV -= bt I
Select info & data sections exported to text file
none ! sitedime as days+hhmmsssss W)
all
v fmain-header i main-header
v (10 file headers |2 file headers
v [file-stony file-stony
v |software software
v (leads leads
v |calculation calculation
v librany library
v [librany-all library-all
v (librany-use libran-use
v |protocol protocol
v |comments comments
v |marctable mark table
v [steps steps
v |beats beats
invalidated beats
selected beats

variability (HEW)
end of report text file
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main table ] report table ]

Select step info & parameters exported to text file

none J

all

1 cpu-date
cpudime
3 sitedime
period4ime
marktype
markdabel
mark-value
mark-unit
4 stepdindex
b stepdabel
& start-index
7
a
5

L85
Pa

lengthiz)

all bts

val bts

gapH

11 successitime)
12 successibeat)

e T T T T W W T T T Y
=

comment table

sections -> txt

steps = tud ! beats - tet statistics precision HRBW -=txt

13 HR_&l_RR

14 al_R#

15 max_consecutd

16 ECG__RR

17 ECG___HR
ECG__ PR
BF__ BB
BF__HR

v|18 BP__ DBP
BF__ dPdt+
v|15 BP__ SBP

BF___MBF
BF___ ABP
BP___D_DM_time
BF___DMN_pres
BF  arca
BF  BRS deltaF
BF___ BRS_deltal
BF__BRS_shiftl
BF___BRS_#
BF__BRS_comel

v |20 BP__ BRS_slope
BF __ rateXpressure
BP__ breathRate

[ I marks included
missing values as "na" (else "0")

[ selected steps only

cpu-date
cpudime
sitedime
step-ndex
stepdabel
start-index
lengthiz)

all bts

val bts

gap#
successftime)
success{beat)
HR_all_RR
all_R#
max_consecutd
ECG__ RR
ECG___HR
BF__ DEF

BP - -5BFP

BF  BRS slope
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main table ] report table ]

Select beat info & parameters exported to text file

none J

all

1 cpu-date
cpudime
3 sitedime
perodime
marktype
markJabel
mark-value
mark-unit
step4ndex
stepdabel
abs-index
relindex
lead
waveindex
waveame
edit-comment
ECG__RR
ECG___HR
ECG__ PR
BF___BH
BP___HR
|6 BP__ DBP
BP__ dPdt+
v|7 BPF__ SBP
BP__ MBP
BP___ARP
BP __ D _DN_time
BP__ DM _pres
BP__ area
v |3 BP__ BRS_deltaP
BPF  BRS deltal
g 12 BP_ BRS shiftl
w5 BP__ BRS #
W
v

LS
Pa

A
[+ 0=

11 BP___BRS_comel

10 BP__BRS slope
BP__ rateXpressure
BP__ breathRate

comment table

sections -> txt

steps -= tut beats - ta statistics precision HRBW -=txt

[] marks included

missing values as "na” (else "0")
[] invalidated beats included

[] Datanalyst format

[ beats from selected steps onfy
[] with FFT spectrum

] sleep scored epochs orly

cpu-date

cpudime

sitedime
ECG__RR
ECG__ HR
BP__ DBP
BF__ SHP
BP__ BRS_deltaP
BF BRS #

BF . BR:> slope
BP__ BRS_comel
BF__ BRS_shiftl
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(Pressure)_ BRS_deltaP (Pressure)  BRS #
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number of up sequences |
(Pressure)__ BRS_slope 0




Calculations

mean BRS slope (up sequences)

SD of BRS slope (up sequences)

#DIV/0!

#DIV/0!




Square root of number of sequences

SE of BRS slope (up sequences)

0

#DIV/0!




paste data in columns B-D (Pressure)__ BRS_deltaP (Pressure)__BRS_#



(Pressure)__BRS_slope

number of up sequences

0




Calculations

mean BRS slope (down sequences)

SD of BRS slope (down sequences)

#DIV/0!

#DIV/0!




Square root of number of sequences

SE of BRS slope (up sequences)

0

#DIV/0!




paste here >

(Pressure) __SBP

Total number of beats

0




Calculations

Total amount of sequences Total amount of sequences per 1000 beats

0 #DIV/0!
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#of analyzed 82753
#edited & va o
#edited & in o

report optior excludes invalidated beats.
experiment marks and comments excluded
missing values reported as 0 (zero).
beats from all steps are listed regardless of step manual selection.
beats from all steps are listed regardless of step manual selection.

#ofbeatsing 82753

#of data line 82753

# of paramet: 20 column index of 1st parameter

site-start

cpu-date cpu-time site-time (ECG)__RR |(ECG)__HR |(Pressure) DBP (Pressure)_SBP (Pressure)_ BRS_deltaP {Pressure)_ BRS_# {Pressure)_ BRS slope  (Pressure)_ BRS correl  (Pressure)_ BRS_shiftl

ms bpm mmHg mmHg

137 437,956 89,604 126,522 0 0 0 1] [
134 447,761 95,551 126,025 o o 0 0 0
128 468,75 94,553 1287678 2_,?42% o 0 ] 133
133 451,128 93,589 124,414§ -4,353 o 0 o 129
129 465,116 96,666 128,257} 3,844 (] o 0 137
137 437,956 90,829 121,809 -6,449 o 0 ] 127
127 472,441 96,865 128,551 6_,?42? o 0 1] 132
132 454,545 91,389 121,552f -6,999, o 0 0 127
127 472,441 97,335 128,?84‘_ 7 233i o 0 ] 131
131 458,015 92,327 121,991F -6,794 0 i} 0 126
126 476,19 97,206 128,605§ 6,614 o 0 1] 129
129 465,116 92,558 121,191% -7,413 o 0 o 126
126 476,19 98,094 130,21§ 9,019 0 0 0 128
128 468,75 93,009 125,527 -4,683 o 0 0 126
126 476,19 97 668 128. 758k 3.231 0 0 1] 126
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209
210
211
312
213
214
215
216
217
21g
219
220
221
222
223
224
225
226
227
224
229
239
231
232
233
234
235
234

237)

Y I o S N = F
#of analyzed 82?53.
#edited & va 1]
#edited & im 0

report optior excludes invalidated beats.

experiment marks and comments excluded

missing values reported as 0 (zero).

beats from all steps are listed regardless of step manual selection.
beats from all steps are listed regardless of step manual selection.

#of beatsiny 82753
# of data line 82733
# of paramet:

site-start
cpu-date cpu-time site-time (ECG)__RR
ms

137
134
128
133
129
137
127
132
127
131
126
129
126
128
126

20 column index of 1st parameter

(ECG)__HR

bpm

437,956
447,761
468,75
451,128
465,116
437,956
472,441
454,545
472,441
458,015
476,19
465,116
476,13
468,75
476,19

{Pressure)_ DBP

mmHg

93,589%

96,666
90,829

96,865F
91,389F

97,335
92,327
97,206

92,558F
P

98,094
93,009

97,668}

(Pressure)_ SBP

136,522

126,025

5

124,414

i

121,809

i

121,552,

LR

121,991

121,191,
it
125,527

(Pressure)_ BRS_deltaP

128,758,

Click hére to access/dowhload;Supplemental File (Figures, P&rmissions,

etc.);SupplementalFile11.pdf

2,742
-4,353
3,844
-6,449
6,742
-6,999
7,233
-6,734
6,614
-7.413
9,019
-4,683
3,231

(Pressure)_ BRS_#

000 000000000000

(Pressure)_ BRS_slope

QO Q0000 o Q00 e e Qoo

(Pressure)_ BRS_correl

Q2 Q0 Q0 Q0 Q 00 Qe Q0 QQQ

(Pressure)_BRS_shiftl

133
123
137
127
132
127
131
126
129
126
128
126
126

183
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Supplemental File 12 g - D
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235|230 |N|o | B w|n |~

| —
|u-|

(Pressure) SBP

paste here > | 126,522
126,025

128,767

124,414

128,257

121,809

128,551

121,552

128,784

121,991

128,605

121,191

130,21

125,527

128,758

125,388

128,663

126,428

etc.);SupplementalFile12.pdf

| Up sequences | Down sequences | All sequences‘

@
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Sort by Color

Chant Ao
Sheet View

? Clear Filter From "(Pressure)_BRS_#"

Filter by Color

Number Filters

1. Click here

(Pressure)__BRS_slope |

|Search

M (Select All)
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Video - timecode

2. Surgical implantation of telemetric transmitters for combined ECG and blood pressure

measurements
Beginning | End
2.1. Dissection of the left common carotid artery. 00:09 04:32
2.11 - -
2.1.2 00:13 00:29
2.1.3 00:29 00:33
2.1.4 00:33 00:41
2.1.5 00:41 01:14
2.1.6 01:14 01:18
2.1.7 - -
2.1.8 01:21 01:40
2.1.9 01:40 01:54
2.1.10 01:54 02:09
2.1.11 02:09 02:29
2.1.12 02:29 03:05
2.1.13 03.05 03:28
2.1.14 03:28 03:39
2.1.15 03:39 04:05
2.1.16 04:12 04:32
2.2. Cannulation of the left common carotid artery 04:32 06:07
2.2.1 - -
2.2.2 04:32 04:38
2.2.3 04:38 04:54
2.2.4 04:54 05:10
2.2.5 05:10 05:39
2.2.6 05:39 06:07
2.3. Placement of the telemetry device body in a subcutaneous pocket 06:07 07:01
on the left flank of the mouse
2.3.1 06:07 06:27
2.3.2 06:27 06:39
2.3.3 06:39 07:01
2.4. Placement of the ECG leads in Einthoven Il configuration 07:01 10:01
241 07:01 07:39
2.4.2 07:39 08:40
2.4.3 08:46 09:12
2.4.4 09:12 09:28
2.4.5 09:28 09:39
2.4.6 09:39 10:01
2.8 Data analysis including determination of baroreceptor sensitivity 10:01 11:00
using the sequence method with ecgAUTO software.
2.8.6 10:08 11:00
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